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1.0 Introduction 

As part of the South Jersey Model Improvement Project (SJMIP), SJTPO retained the URS team 
to migrate the regional travel demand model to Cube/Voyager and implement several 
enhancements to develop a model that is more state-of-the-practice. The model is now more 
user-friendly as well as transparent and utilizes only the Cube/Voyager suite. The previous 
version of the model utilized several software components such as CENTRAL, FORTRAN, 
CLIPPER, MINUTP and TP+.  

Travel demand models involve numerous files and processes and can be challenging to 
comprehend and use without proper documentation. This document aims to provide a user 
with instructions to install the model, understand the modeling input and output files and the 
overall model structure and provides step-by-step instruction to run the model for various 
scenarios. Examples of various analysis tasks that are commonly performed using travel 
demand models are also provided. It is expected that the user is familiar with the Cube/Voyager 
package.  
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2.0 Model Installation 

This section provides system requirements and instructions for installing the SJTDM. 

2.1 System requirements 

Prior to installing the SJTDM, it is required that the Cube/Voyager software and the associated 
license be installed. The instructions to install those can be obtained from Citilabs. The latest 
available version of Cube at this time, version 6.0.1, was used to develop the model. It is 
recommended that about 3GB of hard disk space be reserved per model run scenario. About 10 
GB of hard disk space would be sufficient for the entire model setup including the base year 
and one future year run. The model has been tested on Windows XP and Windows 7 operating 
systems. The model is expected to run faster on a machine with more RAM and multiple cores, 
but a minimum of 3 GB RAM and 4 cores is recommended. 

2.2 Installation procedure 

The SJTDM installation simply requires copying the entire ‘SJTDM’ folder provided as part of the 
installation DVD on any directory. For instance, it could be placed under ‘C:\SJTDM’ or 
‘C:\projects\SJTDM’. It is recommended that the model be placed under ‘C:\SJTDM’. 

SJTDM v3.3 scenario file paths are updated automatically, regardless of where the user places 
the model in the local computer drive.   

2.3 Directory Structure 

After installation, the SJTDM may be opened by double clicking the catalog file sjtdm.cat 
located under the ‘SJTDM’ directory. The model inputs are located under 
SJTDM\Inputs\Scenarios\Base\ and the outputs are stored under SJTDM\Scenarios\Base\. It is 
important for the user to keep this directory structure intact in order for the model to function 
properly.  

The catalog currently consists of a single parent scenario (Scenarios) which contains a child 
scenario Base. The Base scenario contains additional child scenarios such as y2010 and y2040. 
The user may create any number of scenarios, for any analysis year, as the need and data 
becomes available.  It is recommended that added scenarios are managed within the current 
catalog file (sjtdm.cat). 
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3.0 Model Structure 

The SJTDM is a standard 4-step model encompassing the trip generation, trip distribution, 
mode choice and assignment steps. This section describes the model structure within the Cube 
modeling environment. 

3.1 Model Application/Flow Chart 

Once the model catalog is opened in Cube, the flow chart of the modeling steps will be 
displayed, as shown in Figure 3.1. 

Figure 3-1: SJTDM Model Flow Chart (Application Manager) 

 

The flow chart environment is known as the ‘Application Manager’ within the Cube suite and is 
unique to the Cube travel demand modeling software. It depicts the sequence of execution of 
the modeling steps along with all the inputs and outputs for every step. The inputs, outputs and 
the modeling processes are color coded to aid differentiation. All of the input files can simply be 
double-clicked within this environment to open, view and edit it. The ability to add comments 
for every step makes this environment self-documenting. A user has the ability to run the entire 
application or only parts of the application via the Application Manager (this is described in 
detail in Chapter 5). 
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The ‘Scenario Manager’ in Cube, depicted by the left portion of the screenshot in Figure 3-1, is 
complementary to the Application Manager in that it allows a convenient means to organize 
and run multiple scenarios within the same application.  The Scenario Manager has two modes, 
the Model Developer mode and the Model Applier mode. If the former is set via the Catalog 
properties, then all features of the catalog and its applications are available for edit and display. 
If instead the Model Applier option is set, the user is generally restricted to changing data 
values rather than changing the structure of the data. For example, the Applier can change the 
value of a key for a scenario, but cannot change the catalog key properties, or add a new key, or 
delete a key. Double-clicking an application will open it in read-only mode when in Applier 
mode.  The SJTDM application has been setup to open in the Applier mode by default. 

A description of each of the major steps within the SJTDM chain is provided below: 

The SJTDM application is comprised of 12 steps. This section provides a brief description of the 
function of each step. 

1. Initialize Model 

In this step, the speed-capacity table and tolls are read and appended to the input 
geodatabase network. The initial off-peak highway skims are also generated in this step. 

2. Trip Generation 

The non-recreational and recreational trip generation processes are performed in this 
step. The primary outputs are the zonal productions and attractions by trip purpose. 

3. Begin Feedback Loop 

This step contains the beginning of the feedback loop and the number of loops can be 
specified here. The number of feedback loops is set to 4 by default and is recommended 
for conformity runs. For a quick model run especially for testing purposes, this can be 
changed to 1. 

4. Skim 

The peak and off-peak highway skims and the transit skims for the 3 transit time periods 
and two access modes (walk-access and drive access) are generated here. 

5. Trip Distribution 

The trip distribution for the non-recreational and recreational purposes is performed 
here. Trip length frequency distributions are also generated. 

6. Mode Choice 

The trip tables obtained from the trip distribution step are partitioned into the various 
highway and transit modes in this step. 

7. EI Mode Choice 

This step performs the mode choice for the EI trip purposes. This is performed 
separately for three external geographies namely Philadelphia Center, rest of 
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Philadelphia County and Camden. The travel time and cost for auto, bus and rail from 
external stations to these geographies are used as input to perform this mode split. 

8. Temporal Model 

In this step, the daily level II and EI trips by mode are added together and then 
partitioned among the 4 time periods in the model. The seasonal factors by trip purpose 
are also applied in this step. The primary outputs of this step are the highway and transit 
trip tables ready to be assigned to the networks. 

9. Daily Assignment 

This step performs the advanced toll diversion highway assignment. The primary 
outputs are the loaded networks by time of day and a daily loaded network with 
statistics such as VMT, lanemiles, Level of Service as well as V/C ratio and Congested 
speeds for each of the time periods. 

10. End Feedback Loop 

This step closes the loop started in step 3 and copies the loaded highway network and 
highway skims from the current loop into a separate directory FBLoopFiles located 
within the run directory. 

11. Analysis Day Peak Hour Assignment 

The peak hour highway assignments are performed in this step. The primary outputs are 
the loaded highway networks with peak hour volumes. Note that this is performed only 
once outside the feedback loop. 

12. Analysis Day Transit Assignment 

Transit assignment for the two modes (bus and rail) and two access modes (walk and 
drive) are performed separately in this step. The primary outputs are link loadings of the 
route ridership. Note that this is also performed only once outside the feedback loop. 

Each of the above steps contains sub-steps in a parent-child relationship. The parent 
level of the Trip Generation Step is shown in Figure 3-1. The sub-steps can be seen in 
Figure 3-2, which comprise of steps to generate external-external matrix, non-
recreational trip generation, recreational trip generation, combining productions and 
attractions and creation of a database file for reporting purposes. The non-recreational 
trip generation step is also composed of sub-steps shown in Figure 3-3. The recreational 
trip generation step is composed of sub-steps shown in Figure 3-4. 
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Figure 3-2: Sub-steps in Trip Generation Step 
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Figure 3-3: Sub-steps in Non-recreational Trip Generation 
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Figure 3-4: Sub-steps in Recreational Trip Generation 
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3.2 Catalog Keys 

Catalog keys are used to provide a user with a convenient way to access and modify the 
primary model parameters that could be varied for a model run. Keys can be files, numbers, 
Boolean or character strings. These could be varied or kept same across scenarios. For instance, 
the ANALMONTH refers to the analysis month that could vary by scenario whereas the ZONESI 
key refers to the last internal zone number which should be the same across scenarios. Keys are 
sometimes used to enable some parameters to be more transparent to the user. 

The following table provides a description of important catalog keys in the SJTDM that the user 
may need to update for a particular scenario run. 

Table 3-1: Catalog Keys in SJTDM 

 

 

Name Description

runyear Model Run Year

maxiters Maximum No. of Equilibrium Assignment Iterations

fdbkLoops Number of Feedback Loops

ZONESI Last Internal Zone Number

ZONESA Last External Zone Number

ANALMONTH Analysis month for temporal model

ANALDAY Analysis day for temporal model

SelectLink A-node and B-node of l ink for performing select l ink assignment

HOURASSIGN Boolean variable to control whether to run peak hour assignment

AMPEAKHOUR Morning peak hour period selection for peak hour assignment

PMPEAKHOUR Evening peak hour period selection for peak hour assignment
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4.0 Model Input and Output Data 

This section describes all the input files that are required for a model run as well as the relevant 
output files generated from each model step. 

4.1 Input Data Files 

The primary input files required for any scenario model run are shown in Table 4-1 along with 
their description and model step used. 

Table 4-1: SJTDM Input Files 

 

All of the above input files can be opened and edited within the Cube application environment. 
It is important to ensure that these files are present especially when preparing and launching a 
new model scenario run. 

Filename Description Step Used

Network.mdb Geodatabase of highway network Initialize model

Tolls.dbf Toll data Initialize model

TCARDS.DAT Turn penalties Initialize model

ALLLINE.DAT Transit Lines Initialize model\Transit skims

RAILFARE.DAT Rail fares Initialize model\Transit skims

PNR_BUS.DAT Bus PnR Catchment zone list Initialize model\Transit skims

PNR_Rail.DAT Rail PnR Catchment zone list Initialize model\Transit skims

BUSLINK.DAT Casino Shuttle to AC Rail Station Links Initialize model\Transit skims

RAILLINK.DAT AC Rail Links Initialize model\Transit skims

RLXFLINK.DAT Rail Station to Highway Node Links Initialize model\Transit skims

RAILNODE.DAT AC Rail Nodes Initialize model\Transit skims

SJM_EE{XX}.DBF EE Trip file Trip Generation\Non-Rec TG

SJMZDAT.DBF PnR data (cost, type) Trip Generation\Non-Rec TG

CORDONPCT.DBF % Allocation of EI trips to externals Trip Generation\Non-Rec TG

SJMZPOP.DBF SE data Trip Generation\Non-Rec & Rec TG

SJMLIFE.DBF % HH by Lifecycle Trip Generation\Non-Rec & Rec TG

SJMREC.DBF Recreational input data Trip Generation\Rec TG

CASINOEQV.DAT Casino zonal characteristic for casino bus occupancy Mode Choice

EI_distribution.csv % Distribution from externals to 4 geographies EI Mode Choice

EI_LOS_PhillyCtr.csv Modal Time and Cost data from externals to Philly Ctr EI Mode Choice

EI_LOS_PhillyOther.csv Modal Time and Cost data from externals to Philly Other EI Mode Choice

EI_LOS_Camden.csv Modal Time and Cost data from externals to Camden EI Mode Choice

Note - XX refers to scenario year
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4.2 Output Data Files 

The primary output files generated in each step of the model are shown in Table 4-2.  

Table 4-2: SJTDM Output Files  

 

Filename Description Step Generated

PANDA.DBF Non-recreational Productions and Attractions Non-recreational Trip Generation

SJRECTGSHORE.DBF Recreational Shore Productions and Attractions Recreational Trip Generation

SJRECTGACCESS.DBF Recreational Access Productions and Attractions Recreational Trip Generation

SJRECTGCAS.DBF Recreational Casino Productions and Attractions Recreational Trip Generation

SJRECTGEVT.DBF Recreational Event Productions and Attractions Recreational Trip Generation

{XX}TRIPS.MAT Trip Distribution Output - (XX - Trip purpose) Trip Distribution 

SJM{XX}.MAT I-I Mode Choice Output - (XX- Trip Purpose) I-I Mode Choice

ModalTrips.PRN I-I Mode Choice Summary Print File I-I Mode Choice

EI_Split_MC.MAT E-I Mode Choice Output E-I Mode Choice

{XX}VTRIPS.MAT Highway Trip Table (XX - Time of Day) Temporal Model

BusTrips_{XX}.MAT Bus Trip Table (XX - PK, OP) Temporal Model

RailTrips_{XX}.MAT Rail Trip Table (XX - PK, OP) Temporal Model

{XX}LOADED.NET Loaded Network (XX - Time of Day) Highway Assignment

HWYLOADS_TD.NET Daily loaded network Highway Assignment

TASSN_XX_YY Transit Link Output (XX - Mode, YY - PK, OP) Transit Assignment
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4.3 Network Attributes 

A description of the unloaded highway link attributes are provided in Table 4-3. These 
attributes should be reviewed and updated accordingly whenever a user adds a link or needs to 
modify attributes of an existing link as a result of project coding effort. Note that a few 
attributes shown in the table, which are related to signalization, are not being used in the 
current model but are being preserved for future use when the data becomes available. 

Table 4-3: Input Highway Network Link Attributes 

 

 

Table 4-4 provides a list of the major loaded highway network link attributes. Note that in the 
table, '_1' represents results of the first assignment. If the input network already had the 
loaded attributes appended with '_1', the loaded volumes will be appended with '_2' (i.e 1 
more than the input network's assignment #). 
 
 
 
 
 
 

Field Description

A A node - The node number of the upstream end of the link

B B node - The node number of the downstream end of the link

DISTANCE Link distance (in hundredths of a mile with an implied decimal)

FC Functional Class

AT Area Type

FT Facility Type

LANES Number of Lanes

SPDADD Speed Lookup Adjustment (Additive in %)

SPDSUB Speed Lookup Adjustment (Subtracted in %)

CAPADD Capacity Lookup Adjustment (Additive in %)

CAPSUB Capacity Lookup Adjustment (Subtracted in %)

NSIG Number of Signals (Not used - for future use)

ARRTYPE Arrival Type Indicator (Not used - for future use)

GC Green to Cycle Ratio (Not used - for future use)

CYCLE Cycle length (Not used - for future use)

NAME Street Name

COUNTY County Code

TOLLROAD Toll Road Indicator (=1 if Toll Road)

TOLL Toll (cents)

COUNT_SPRING Spring counts conducted in this study and AADT counts from other sources

COUNT_SUMMER Summer counts conducted in this study
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Table 4-4: Loaded Highway Network Link Attributes 

 

Field Description

V_1 Combined volume from all modes

TIME_1 congested link travel time (min)

VC_1 volume-to-capacity ratio

CSPD_1 congested speed (mph)

VDT_1 vehicle-distance traveled (vehicle-miles)

VHT_1 vehicle-hours traveled

V1_1 loaded volume for free-SOV mode

V2_1 loaded volume for toll-SOV mode

V3_1 loaded volume for free-HOV mode

V4_1 loaded volume for toll-HOV mode

V5_1 loaded volume for free-comm veh mode

V6_1 loaded volume for toll-comm veh mode

V7_1 loaded volume for free-truck mode

V8_1 loaded volume for toll-truck mode

V9_1 select link loaded volume for free-SOV mode

V10_1 select link loaded volume for toll-SOV mode

V11_1 select link loaded volume for free-HOV mode

V12_1 select link loaded volume for toll-HOV mode

V13_1 select link loaded volume for free-comm veh mode

V14_1 select link loaded volume for toll-comm veh mode

V15_1 select link loaded volume for free-truck mode

V16_1 select link loaded volume for toll-truck mode

VT_1 bi-directional total loaded volume from all modes

V1T_1 bi-directional total loaded volume for free-SOV mode
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Table 4-5 presents a description of transit network attributes. Whenever a user edits the transit 
network, these attributes should be reviewed or modified as needed. 

Table 4-5: Transit Network Attributes 

 

 

Attribute Value Description

1 Casino Shuttle (Atlantic City Rail Station to Casinos)

2 Local Jitney-Type Service, includes AC and OC Jitneys

3 NJ Transit Local Bus

4 NJ Transit Regional Bus

5 Atlantic City Rail Line

13 Sidewalk

16 Walk Access Connector

17 Drive-Access Connector

1 NJ Transit (South Jersey Region)

2 NJ Transit (DVRPC Region)

4 Private Operator Jitney (AC routes)

6 Salem County

7 Five-Mile Beach Electric Railway Company

1 Winter AM Peak

2 Winter Off-Peak

3 Summer Off-Peak

Mode

Owner

Period



  USER’S GUIDE  
SOUTH JERSEY TRAVEL DEMAND MODEL   October 2012  

SOUTH JERSEY TRAVEL DEMAND MODEL (SJTDM) IMPROVEMENTS PAGE 15 
FY 2011-2012  

5.0 Model Execution 

5.1 Full Model Execution 

Once the catalog is opened in Cube and the SJTDMv3.3 application is launched, the entire 
model chain can be executed by first double-clicking a particular scenario, check the model 
parameters to ensure they are correct and then press the “Run” button to start the full model 
run. Figure 5–1 shows the scenario run window. The model set to perform 4 feedback loop 
iterations. A complete model run with 4 feedback loops on a computer with 3.5 GB RAM and 4 
cores requires about 9 hours. 

Figure 5-1: SJTDM Scenario Run Window  

 

5.2 Single Application Group Execution 

If the user needs to run only a selected component of the SJTDM, especially useful during 
sensitivity testing to evaluate the effect of a change on a particular modeling step, this can be 
accomplished by double-clicking a ‘Parent’ step (such as ‘Initialize Model’) and then clicking the 
‘Run Application’ button and checking the ‘Run Current Group Only’ checkbox. This is shown in 
Figure 5-2. Upon hitting OK, a task monitor window will launch which displays the progress of 
the execution of that step, as shown in Figure 5-3. 



  USER’S GUIDE  
SOUTH JERSEY TRAVEL DEMAND MODEL   October 2012  

SOUTH JERSEY TRAVEL DEMAND MODEL (SJTDM) IMPROVEMENTS PAGE 16 
FY 2011-2012  

Figure 5-2: Illustration of running selected application group in Cube 

 

 

Figure 5-3: Task Monitor during a single application group run  
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6.0 Model Summaries/Reports 

Once the model execution is complete, the outputs from the various steps of the modeling 
chain can be summarized in an Excel spreadsheet or can be viewed via Cube Reports. This 
section provides guidance on how to perform the summaries. 

6.1 Model Output Files for Spreadsheet Summaries 

The output files generated from a model run that are relevant for performing spreadsheet 
summaries are shown in Table 6-1. Some of these are automatically generated by the model 
run whereas a few are generated after running Voyager scripts. These scripts are only relevant 
to the base year 2010 (such as ‘Attach traffic counts.s’) and thus have not been incorporated 
into the model chain. 

Table 6-1: Model Output Files for Spreadsheet summaries 

 

6.2 Cube Reports 

Citilabs has incorporated a reporting package known as Cube Reports into the standard Cube-
Base installation (this used to be a separate stand-alone package in addition to Cube-Base in 
earlier versions of Cube). Cube Reports provide the ability to view table, graphs and charts of 
summarizing model outputs within the Cube environment. The reports require the 
development of input files that should be of a specific format. Each report can have only one 
data source. 

As part of the SJTDM enhancements, several Cube Reports have been developed and 
incorporated into the model application. Table 6-2 provides a summary of the reports and their 

Filename Spreadsheet Used Source

PANDA.DBF Non-recreational Trip Generation Step

SJRECTGSHORE.DBF

SJRECTGACCESS.DBF

SJRECTGCAS.DBF

SJRECTGEVT.DBF

trip distribution output.prn Print trip distribution matrices.s

avg_triplen.dbf Trip Length.s

ModalTrips.prn Mode Choice - 2010.xlsx Mode Choice step

RMSE.PRN RMSE.s

Tppl*.prn crosstab.s

TASSN_WBUS_PK.dbf

TASSN_WRAIL_PK.dbf

TASSN_WBUS_OP.dbf

TASSN_WRAIL_OP.dbf

TASSN_DBUS_PK.dbf

TASSN_DRAIL_PK.dbf

TASSN_DBUS_OP.dbf

TASSN_DRAIL_OP.dbf

Trip Distribution -2010.xlsx

Trip Generation -2010.xlsx

Highway Assignment-2010.xlsx

Transit Assignment - 2010.xlsx

Recreational Trip Generation Step

Transit Assignment Step
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description. The inputs for each of the reports are automatically generated via Voyager scripts 
during the execution of the model chain. In order to view the reports, simply double-click the 
report name under Data->Reports in the SJTDM application. 

Table 6-2: Cube Report descriptions 

 

The Cube Report depicting a summary of the Mode Choice Step in the SJTDM is shown in Figure 
6-1.  

Figure 6-1: Cube Report for SJTDM Mode Choice Step 

 

Report Name Description

TripGen Pie chart and table of trip productions and attractions 

TLFD Graph of model-estimated trip length frequency distribution

ATL Table of average trip lengths

Mode Choice Pie chart of mode shares

HwyAsgn Cross tabulations of volume, count, VMT and VHT by FT and AT

VMT by LOS Table showing VMT by LOS and FT for AM and PM peak period

Lane Miles by LOS Table showing Lane Miles by LOS and FT for AM and PM peak period
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7.0 Common Analysis Tasks 

This section provides instructions on performing some common analysis tasks using the SJTDM 
Cube Model. It is assumed that the user has some basic knowledge of Cube-Base and the 
Voyager scripting language. The Cube/Voyager Help or the documentation can be referred to 
for additional reference. 

7.1 Socioeconomic Data Update 

One of the common tasks in travel demand modeling is to update the socioeconomic data input 
for a particular scenario. This could be applicable to a few zones within a corridor or for all the 
zones in the entire modeling area. If only a few zones need to be edited, it can be done directly 
within the SJTDM Cube modeling environment. For instance, if the population in TAZ 1 needs to 
be updated, the SJMZPOP.DBF file located in the application as an input to the trip generation 
step (see Figure 7-1) can be opened in Cube by simply double-clicking it. Once it is opened 
(Figure 7-2), simply click the cell corresponding to the POP field and TAZ 1 and enter the revised 
population. This is a convenient method to update data for a few TAZs. 

Figure 7-1: Socioeconomic Input Data file location in SJTDM application 
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Figure 7-2: Socioeconomic Input Data file opened in Cube 

 

If the socioeconomic data attributes of the entire model area need to be updated, it is best 
done by opening the SJMZPOP.DBF file (located under \sjtdm\Inputs\Scenarios\Base\y2010 if 
the 2010 data is to be updated) as an Excel spreadsheet, saving it as an Excel spreadsheet, 
performing the calculations or updates in Excel and then converting it back to DBF format via 
Microsoft Access. 

7.2 Highway Network Update 

Another common modeling task is to update the input highway network either to correct a 
previously overlooked coding error or to edit it based on revised assumptions. The input 
highway network can be opened in Cube by double-clicking the ‘Network’ geodatabase file 
which is an input to the ‘Initialize Model’ step (See Figure 7-3). This would open the network in 
the ‘GIS Window’ in Cube (Figure 7-4). If desired, a shapefile of the street layer can be opened 
in Cube to aid in the network editing task, by clicking on the ‘Add Data’ icon (a plus sign) and 
adding a shapefile by browsing to the directory containing the shapefile of the streets. 
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Figure 7-3: Input highway network location in SJTDM application 
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Figure 7-4: Input highway network opened in Cube 

 

The network can be modified by first clicking Editor->Start Editing, click ‘Select Features’ and 
then click the desired link to bring up the ‘Feature Explorer’ dialog box (Figure 7-5). The link 
attributes can be edited by simply typing in the updated values. The link can also be split by 
clicking the ‘Split Link’ button in the Feature Explorer and specifying an intermediate node 
number at the prompt. 
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Figure 7-5: Feature Explorer in Cube 

 

To add a new link, first ensure that the link layer is selected from the ‘layers’ drop-down menu, 
click the ‘Create Feature’ button (pencil icon) which would cause the cursor to appear like a 
pencil, click the anode and then the bnode to create a link between an existing anode and 
bnode. If the link is to be created from an anode to a bnode that does not exist, the bnode 
should be specified while terminating the link creation task.  

In order to add shapes to the links, click ‘Edit Vertex’ under the ‘Editor’ button and then click 
the desired location on the link to add the vertex. 

Once all the edits are complete, click on ‘Save Edits’ under the ‘Editor’ button. 

The user can save a ‘log file’ of the network changes if the same changes need to be applied to 
another highway network automatically. A log file is a text file (see Figure 7-6 for an example) 
that ‘records’ the link and node edits. This is a useful feature wherein the changes need not be 
manually repeated in another network thus avoiding errors and inconsistencies. The log file can 
be saved by clicking the ‘save log file’ button. The log file can be applied to another network by 
first opening that network in Cube, clicking on ‘Play log file’ button, navigating to the directory 
location where the log file was saved and then double-clicking the log file to apply the network 
edits. 
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The above is not an exhaustive list of network editing tasks in Cube, but the most frequently 
encountered in typical modeling applications. For a complete and comprehensive description of 
all the highway network editing tasks possible in Cube, please refer to the Cube Base Help or 
Documentation. 

Figure 7-6: Example Log File created using Cube 

HighwayLayerLogX,"C:\sjtpo\Inputs\SJTPO-Scenarios\y2002-

Validation\LRTP2035\y2010-Base\SJM_2010_Updated Highway 

Network.net",6,46,1/25/2012 2:28:34 PM 

Node,N,X,Y,SUB_TYPE,OLD_NODE,TAG 

Link,A,B,DISTANCE,TSVA,SPDCLASS,CAPCLASS,LANES,CDEV,FC,AT,FT,SPDADD,SPD

SUB,CAPADD,CAPSUB,NSIG,ARRTYPE,ADDLN,GC,CYCLE,ZONE,REGION,TOLL,HOVFLAG,

DROP,FREELINK,SPDLIM,RTCODE,NAME[24],CURVE,EXTERNAL,TAG,AADT,AADT1WAY,C

OUNT_SOURCE,DVRPC_CNT,NEWLINK,LOC_NUM,DIRECTION[2],AM_CNT,PM_CNT,MD_CNT

,AC_AADT,AC_AADTSTR[5],SCNCODE,SJCNT[11] 

N,A,0,60506,-74.58786,39.27512,0,0,0 

N,A,1,60577,-74.8186,38.98573,0,0,0 

N,A,2,60761,-75.03767,39.47068,0,0,0 

N,A,0,60409,-74.65003,39.53338,0,0,0 

N,A,1,61445,-74.8143,39.63304,0,0,0 

N,D,2,60409,-74.65003,39.53338,0,0,0 

N,A,0,61409,-74.64967,39.53323,0,0,0 

N,A,1,62255,-74.51098,39.46339,0,0,0 

N,A,2,62526,-74.65947,39.25046,0,0,0 

7.3 Transit Network Update 

Since the SJTPO model includes transit routes that are either entirely within the model area or 
partially within the model area, the transit network editing process is described separately for 
these two scenarios. 

7.3.1 Internal Transit Network Coding 

The SJTDM transit network comprises primarily of the ‘alline.dat’ route file, located under 
‘C:\sjtdm\Inputs\Scenarios\Base\y2010’ for 2010 as an example, and is a text file that can be 
opened in Cube or any text editor such as notepad. One of the basic changes that sometimes 
need to be made to the transit network is editing the frequency of selected buses based on 
updated information from schedules. This can be done by opening the allline.dat file (see figure 
7-7 of this file opened in Cube), clicking ‘Search->Find’ and entering the route name of the 
bus/train that is needed to be modified, and typing the revised frequency (in the FREQ[1], 
FREQ[2] or FREQ[3] fields as applicable) corresponding to the LINE NAME that is found via the 
search. Other attributes such as RUNTIME can also be updated via the same procedure. 
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Figure 7-7: SJTDM transit route file opened in Cube 

 

If a particular transit route needs to be re-aligned, it is best done graphically in Cube rather than 
the text file approach described above. First the highway network in *.NET format 
(NetwithSpdcap.NET) should be opened in Cube. The transit route file can be opened as 
another layer by clicking on ‘Layer Control’, double-clicking Transit layer, browsing to the 
allline.dat file located in the SJTDM\Inputs\Scenarios\Base directory for the particular model 
run and double-clicking it. The entire transit network would appear as shown in Figure 7-8. To 
display only the route that the user is interested in editing, click on ‘Display Transit Line’ to 
select the route name from the list on the left (figure 7-9). 
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Figure 7-8: SJTDM Transit Network in Cube 

 

 
  



  USER’S GUIDE  
SOUTH JERSEY TRAVEL DEMAND MODEL   October 2012  

SOUTH JERSEY TRAVEL DEMAND MODEL (SJTDM) IMPROVEMENTS PAGE 27 
FY 2011-2012  

Figure 7-9: Display selected transit route 

 

Next, the user should ensure that the transit layer is on top of the highway layer under the 
Layer drop down box. The selected route can be double-clicked and edited graphically by 
clicking on the Route Edit button in the Transit Route dialog box (Figure 7-10). The cursor will 
turn into a crosshair, and the user can click on highway nodes to add stations along the route. IF 
a station is to be a non-stop, the user should click ‘Alt’ before clicking the node to add a ‘-‘ 
preceding the node to indicate a non-stop. 
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Figure 7-10: Transit Route Editing dialog box 

 

 

The Cube Manual can be referenced for additional transit network edits. 

7.3.2 External-Internal Transit Network Coding 

Certain transit routes in the SJTDM extend beyond the modeled area in reality. For instance, 
the Atlantic City Rail Line is coded in the model as terminating at the Atco station which is 
located at the model boundary whereas in reality it continues beyond that station and 
terminates in Philadelphia. This section describes how to code a new transit project that is 
located partially within the model area and extends beyond the model boundary, such as the 
proposed Camden Gloucester Rail project. Firstly, the internal portion of the line route should 
be coded in the ‘Allline.dat’ file and the physical links in the ‘Raillinks.dat’ file. Catchment zones 
for any proposed park-n-ride lots should be coded in the PNR_Rail.dat file. In order to represent 
the portion of the project outside the model boundary, the rail time and cost (fare) fields (these 
represent the runtime and fare from the external station to the final destination) should be 
entered for the appropriate external station in the Level-of-Service data files 
(EI_LOS_PhillyCtr.csv for Philly Center area, EI_LOS_PhillyOther.csv for Other Philadelphia 
County areas and EI_LOS_Camden.csv for Camden City areas), located under the EI Mode 
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Choice application step (see Figure 7-11). This file, which is a proxy for the external portion of 
the transit network, is in csv format so that calculations can be performed if needed; steps 3-5 
convert this to a dbf file. Figure 7-12 shows this file in dbf format. Please refer to the Model 
development report to obtain an understanding of how the EI Mode Choice process works. 

Figure 7-11: Level of Service file location in SJTDM application 
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Figure 7-12: LOS input file in dbf format 

 

7.4 Select Link Analysis 

Select-link analysis is used to identify the origins and destinations of traffic that traverse a 
particular highway network link. This can be accomplished in Cube/Voyager by adding special 
syntax in the highway assignment Voyager script’s PATHLOAD statement to accommodate the 
additional select link volume fields. An example of what this statement would look like is shown 
below. 

path = cost, peni = 1, VOL[1]=mw[XX],excludegrp=1,                     

         mw[5]=mw[XX],selectlink=(L=anode-bnode), 

                  vol[9]=mw[5] 

In the above example, VOL[1] stores the regular volume and VOL[9] stores the select link 
volume. The SJTDM assignment script has already been setup to perform select link analysis for 
one link. The user may modify this link as needed by entering the required link’s A-node and B-
node on the model run screen as shown in Figure 5.1. The select link volumes can be visualized 
via the SLVOL24 field in the daily loaded network HWYLOADS_TD.NET. 



  USER’S GUIDE  
SOUTH JERSEY TRAVEL DEMAND MODEL   October 2012  

SOUTH JERSEY TRAVEL DEMAND MODEL (SJTDM) IMPROVEMENTS PAGE 31 
FY 2011-2012  

It is important to remember to add a statement in the ADJUST phase of the assignment step to 
exclude the select link volume fields from the total volumes used to compute V/C ratio in 
successive assignment iterations. This statement (already added in the SJTDM) would be as 
follows (the select link volumes would be beyond the 8 volume sets shown here): 

FUNCTION  { 

      v     = vol[1] + vol[2] + vol[3] + vol[4] + vol[5] + vol[6] 

+ vol[7] + vol[8] 

} 

If more information is needed about this process, the select link processing section of the 
VOYAGER reference guide should be consulted.  

7.5 Turning Movement Volume Display 

Cube has the ability to display modeled turning movement volumes at intersections, provided 
that those were saved during the highway assignment step. In order to save the turns, open the 
highway assignment script (see Figure 7-13 for location of the script) for the desired time 
period (or all time periods, if needed) and add a statement below the listing of input/output 
files as follows: 

turns n=4727,4746,5396 

where the numbers represent the node numbers where the turns are needed. 

After running the highway assignment with the above change, the loaded network 
(AMLOADED.NET for example) can be opened in Cube, and then click Intersections-> Output 
File and navigate to amturns.trn located under the model scenario run directory and double-
click it. Zoom into the node (such as 4727), click it and then click on the ‘Show Output 
Intersection Data’ button (Figure 7-14) to display the turning movement volumes (Figure 7-15). 
The various volume sets (1 to 8) represent the loaded volumes for the various modes in the 
assignment model which are free-SOV, toll-SOV, free-HOV, toll-HOV, free-commveh, toll-
commveh, free-truck and toll-truck. Additional volume sets will be present when performing 
select link assignment, in which case it should be ensured that the those volume sets are not 
pressed in the top left portion of the turning movement volume display. 
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Figure 7-13: Location of highway assignment script in SJTDM application 
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Figure 7-14: Show Output Intersection Data button 
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Figure 7-15: Turning movement volume display in Cube 

 

7.6 Development of new Cube Reports 

The SJDTM application includes several Cube Reports that aid in viewing summaries of various 
modeling steps. This section provides guidelines on how the reports were developed so that a 
user can create new ones. The first step is designing the report – identifying what fields go in 
the report, what is the measure or statistic that the user desires to display, whether the report 
should present the data in tabular format, as a pie chart or as a chart, and whether the model 
automatically generates that data in the format that a Cube Report can read.  These formats 
include database files (*.dbf), matrix files (*.mtx), highway network files (*.net) or tables in 
geodatabase files (*.mdb). If the required data is not readily available from the model, it could 
be generated via custom Voyager scripting.  

The SJDTM includes a report for generating a pie-chart for trip productions by purpose. The 
development of this report is shown here as an example. In the SJTDM Scenario manager under 
Data->Reports, right click on TripGen->Edit and view the information that has been entered 
(input data, fields needed, format of report, etc – see Figure 7-16). All the other tabs can be 
viewed to understand how the report was created. Please refer to the Cube Base 
documentation for further details on Cube Reports.  
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Figure 7-16: Cube Reports Definition 

 

7.7 Development of new scenario/run year 

The SJTDM currently includes the base year 2010 and future year 2040 runs. It may be desired 
to add additional scenarios for the same model run year (such as 2040) or create an entirely 
new model run year (such as 2030). In the SJTDM application, a new scenario can be created by 
adding one as a sibling or as a child in the Scenario Manager. If a scenario is added parallel to an 
existing scenario, it is called the sibling scenario. If the scenario is added underneath an existing 
scenario, it is called the child scenario. If a scenario is added as sibling, it is very important to 
make sure all the model inputs and parameters within the scenario (also known as catalog 
keys) are updated as needed. See Section 3.2 for more information on catalog keys. If a new 
scenario needs to be added for an alternatives analysis, it is recommended to add it as a child to 
the Base scenario. Adding scenarios as child permits automatic copying of the catalog keys of 
the parent scenario to the child scenarios. This reduces the burden on the user to update all 
catalog keys; however, care should be exercised in verifying the catalog keys to make sure they 
represent the scenario. Figure 7-17 shows the creation of new Scenario in the SJTDM Scenario 
Manager.  
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Figure 7-17: Creation of new Scenario in SJTDM Scenario Manager 

 

To set up a new scenario for use within the SJTPO v3.3 model a total of 22 input files need to be 
prepared.  The key input files for a model run were discussed in section 4.1. Sometimes it may 
not be required to prepare all of these files from scratch; it can be copied from an existing 
scenario if the underlying assumptions for data in that file are the same. All required input files 
for a new scenario should be placed in a directory under the SJTDM INPUTS sub-directory in a 
hierarchical manner that complies with the scenario structure. 

7.8 Subarea extraction/assignment 

Subarea extraction/assignment is used to develop a subset of the highway network and trip 
table and perform a highway assignment to generate loaded highway volumes on the subarea 
network. This section provides guidance on accomplishing this in the SJTDM Cube model.  

First, a subarea network needs to be created from the entire model highway network. This can 
be done by opening the highway network (NetwithSpdcap.NET), click Drawing Layer->New to 
draw an imaginary boundary of the subarea (Figure 7-18), click Drawing Layer->SubArea 
Extraction, provide a name for the subarea network, accept or modify the default zone/node 
numbering system proposed for the subarea network (Figure 7-19) and save the subarea in the 
model run directory as ‘Subarea.net’. The turn penalty file should also be renumbered 
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accordingly after removing records that are irrelevant for the subarea and saved in the scenario 
input folder as ‘Tcards_subarea.dat’. 

Once a subarea network has been extracted, a sub-area matrix extraction and sub-area 
assignment can be performed via the Subarea Assignment application in the SJTDM by double-
clicking that application (see Figure 7-18) and then clicking Run->run Current Group only. 

Figure 7-18: Polygon definition for subarea network 
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Figure 7-19: Zone/Node renumbering for subarea network 

 

7.9 TAZ Splits  

The TAZ system in the latest version of the SJTDM has been modified considerably in 
comparison to the previous version of the model. Table 7-1 shows the revised TAZ system. As 
can be seen from the table, several gaps were left in each county as reserve zones that can be 
used when TAZs need to be split.  
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Table 7-1: TAZ System in SJTDM 

 

An example application of TAZ split would be to add a TAZ for a new casino in Atlantic City. The 
new TAZ should be in the range 156-175 to comply with the above TAZ system. The 
socioeconomic data files such as SJMZPOP.DBF, SJMREC.DBF, SJMLIFE.DBF and SJMZDAT.DBF 
should be updated to reflect the additional TAZ number that is introduced as a result of this 
split. If the number of split TAZs exceeds the available total spare TAZs (240), a major 
restructuring of the zonal system would be needed. 

7.10 Sensitivity Tests 

7.10.1 Network Tests 

One of the common sensitivity tests performed using travel demand models is by modifying 
certain aspects of the highway network such as number of lanes or increasing the speed or 
capacity of links. The number of lanes or any highway link attribute can be modified following 
the steps mentioned in section 7.2. The speed or capacity can be modified either for the entire 
facility type/area type/lane combinations or for selected links. If the former, it can be done via 
the speed-capacity table, located as shown in Figure 7-20 under the Initialize Model Step. Upon 
double-clicking it, the table opens up as shown in Figure 7-21. The free flow or initial congested 
speeds and/or capacities can be modified as needed. 

If the speeds or capacities of only a selected links need to be modified without altering the 
speeds and capacities of other links in the network that belong to the same facility type, area 
type and number of lane categories, it can be done by modifying the spdadd, spdsub, capadd 
and capsub link attributes directly in the highway network. These represent % additions or 

Region # Zones Zone Range

Atlantic City 155 1-155

Atlantic City spare zones 20 156-175

Atlantic County Recreational Zones 27 176-202

Atlantic County Recreational spare zones 18 203-220

Rest of Atlantic County 257 221-477

Atlantic County spare zones 23 478-500

Cape May County Recreational Zones 132 501-632

Cape May County Recreational spare zones 18 633-650

Rest of Cape May County 71 651-721

Cape May County spare zones 29 722-750

Cumberland County 253 751-1003

Cumberland County spare zones 22 1004-1025

Salem County 130 1026-1155

Salem County spare zones 20 1156-1175

Gloucester County 97 1176-1272

Gloucester County spare zones 28 1273-1300

Camden County 38 1301-1338

Camden County spare zones 12 1338-1350

Additional reserve for all counties zones 50 1351-1400

SJ External 34 1401-1434

Total spare zones 240
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subtractions from those obtained via the speed-capacity table. For instance, if a 10% increase is 
desired for the capacity for a few links, capadd=10 for those links. 

After making the required changes, the model can be run and the results evaluated to quantify 
the impact of the change. The highway assignment loaded volumes are a good indicator of the 
effect of network changes. 

Figure 7-20: Speed-capacity table location in SJTDM application 
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Figure 7-21: Speed-Capacity Table in SJTDM 

 

7.10.2 Socioeconomic Growth Tests 

The SJTDM includes the base year 2010 and a future year 2040 scenario model runs. The 2040 
scenario, specifically the socioeconomic data, was developed based on the latest assumptions 
on the growth that is expected to occur between 2010 and 2040. It may be desired to test a 
more aggressive growth rate compared to what was assumed or to test a policy such as smart 
growth. For such a sensitivity test, the 2040 socioeconomic data file (SJMZPOP.DBF) should be 
prepared via calculations in Excel and saved back as a DBF file, as described in section 7.1. The 
effect of this test can be evaluated via a review of the loaded network volumes or VMT (via 
Cube Reports) after running the model. 

7.10.3 Trip Rate Tests 

 The trip generation rates in the SJTDM were developed based on data obtained from surveys 
conducted in the region. It may be desired to test the effect of higher or lower trip rates on the 
model results. The non-recreational trip production rates are specified in the PRATES.CSV and 
ARATES.CSV files located in the Non-Recreational Trip Generation step in the SJTDM application 
(See Figure 7-22). Note that there are steps for converting these files to DBF Format; Figures 7-
23 and 7-24 show these files opened in DBF format. 
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Figure 7-22: Location of Production and Attraction rate files in SJTDM application 

 



  USER’S GUIDE  
SOUTH JERSEY TRAVEL DEMAND MODEL   October 2012  

SOUTH JERSEY TRAVEL DEMAND MODEL (SJTDM) IMPROVEMENTS PAGE 43 
FY 2011-2012  

Figure 7-23: Non-recreational Trip Production File 

 

The 30 rows of data in the production rates file comprise of 3 life-cycles, 4 income categories 
and 5 Household size categories. The above figure describes the order in which the rates should 
be read. 
  

Income 1 

Income 2 

Income 3 

Income 4 

LifeCycle 1 

LifeCycle 2 

LifeCycle 3 

HH Sizes 
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Figure 7-24: Non-recreational Trip Attraction File 

 

The effect of this test can be evaluated via a review of the loaded network volumes or VMT (via 
Cube Reports) after running the model. 

7.10.4 Toll Rate Tests 

The tolls on the toll roads in the SJTDM 2010 scenario were updated to reflect the latest 
available information from the toll agencies. It may be desired to test the effect of a toll 
increase for the entire system or selected toll roads. The tolls in the SJTDM are specified in the 
TOLLS.DBF file located in the Initialize Model step (See Figure 7-25). This file, which contains the 
highway network anode, bnode, toll in cents and location, is shown in Figure 7-26. 
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Figure 7-25: Location of Toll File in SJTDM application 
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Figure 7-26: Toll File  

 

If the toll changes are only at a few locations, they can be performed directly in the DBF file, 
otherwise they can be performed in Excel (especially if it involves calculations) and saved back 
as a DBF. 
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